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Documentation Updates
The title page of this document contains the following identifying information:
l

Software Version number, which indicates the software version.

l

Document Release Date, which changes each time the document is updated.

l

Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go
to:
http://h20230.www2.hp.com/selfsolve/manuals
This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, go to:
http://h20229.www2.hp.com/passport-registration.html
Or click the New users - please register link on the HP Passport login page.
You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:
http://www.hp.com/go/hpsoftwaresupport
This web site provides contact information and details about the products, services, and support
that HP Software offers.
HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed to manage your business. As a
valued support customer, you can benefit by using the support web site to:
l

Search for knowledge documents of interest

l

Submit and track support cases and enhancement requests

l

Download software patches

l

Manage support contracts

l

Look up HP support contacts

l

Review information about available services

l

Enter into discussions with other software customers

l

Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:
http://h20229.www2.hp.com/passport-registration.html
To find more information about access levels, go to:
http://h20230.www2.hp.com/new_access_levels.jsp
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Chapter 1
Introduction
This guide explains how to install and configure Cloud System Chargeback (CSC) for Matrix
Operating Environment (MOE) or for Cloud Service Automation (CSA).
This guide explains:
l

Which programs belong to CSC

l

In which environments CSC functions

l

How to install CSC

l

How to configure CSC
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Chapter 2
Components of CSC
The following programs and components are installed and deployed by the CSC installer:
l

CSC Windows client: A Windows graphical interface that enables you to configure and
manage the chargeback system.

l

Web tier and Web service: After the installer finishes installing CSC, the Web tier and the
Web service are deployed automatically. End users can simply access the CSC Web client
through a Web browser after the Web tier and the Web service is started.

l

CSC Admin configuration tool: A batch of configuration files (.bat files) that enable you to
manually configure the MOE or CSA server information, such as the server name, the
connection port, and user authentication.

l

Automated process manager: A system for monitoring deadlines and automatically triggering
actions. CSC leverages a batch of connection scenarios to integrate with MOE and CSA. The
connection scenarios are pre-configured and are run automatically in the Automated process
manager after the installation.

l

HP AutoPass: A license management tool that allows you to activate CSC and related
components.

l

Third-party/Open-source components
n SAP Crystal Report Server: CSC leverages the SAP Crystal Report Server to provide the
reporting services for the chargeback system.
n

Java Runtime Environment 7: JRE 7 is installed automatically to support the use of CSC
Web applications.

n

Tomcat 7: Tomcat 7 is installed automatically as the application server that hosts the CSC
Web application.

n

Microsoft Visual C++ 2008 Redistributable Package: The DLL libraries.

n

Microsoft SQL Server 2012 Express: Microsoft SQL Server 2012 Express edition is
installed as the database server.
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Chapter 3
Supported environments
This chapter describes the supported operating systems and system specifications.

Supported operating systems and database
servers
The release version of CSC can only be installed on a server that is running the 64 bit version of
Windows Server 2008 R2.
Other than the SQL Server 2012 Express Edition that is bundled in the CSC installer, the following
database servers are also supported by CSC:
l

Microsoft SQL Server 2005 SP1 or later

l

Microsoft SQL Server 2008

l

Microsoft SQL Server 2008 R2

l

Microsoft SQL Server 2012

Supported Web browsers
All CSC users can access the CSC Web site by using one of the following browsers:
l

Microsoft Internet Explorer version 7, 8, 9, and 10

l

Mozilla Firefox version ESR10.0.x (x>=7)

Minimum and recommended system specifications
The minimum system specifications for CSC are as follows:
Operating system

Windows Server 2008 R2

CPU

Intel Xeon or equivalent

RAM

4 GB

Disk space

30 GB

The recommended system specifications for CSC are as follows:
Operating system
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CPU

Intel Xeon or equivalent

RAM

6 GB

Disk space

50 GB
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Chapter 4
Installing CSC
This chapter provides step-by-step instructions to install and deploy CSC.

Prerequisite
You must have Windows administrative rights to install CSC. Without these rights, the installation
program cannot modify the registry.

Installation procedure
Make sure that the server meets all the requirements described in "Supported environments" on
page 9, and then follow these steps:
1. Launch the setup.exe program on the installation media.
2. Follow the instructions provided by the installation wizard to complete the preparation state:
a. Select the option HP Asset Manager CloudSystem Chargeback 9.40 (en) For Matrix
OE or HP Asset Manager CloudSystem Chargeback 9.40 (en) For Cloud Service
Automation.
b. Read and accept the terms in the license agreement.
c. Install Microsoft SQL Server 2012 Express edition and relevant components as prompted.
d. Confirm the database server that CSC connects to. You do not need to change the
database server.
e. When the configuration pane appears, fill in the host information according to the following
tables:
Note: Make sure that you populate the host information correctly. Otherwise, CSC
cannot successfully connect to MOE or CSA. When you are in this situation, use the
CSC configuration command-lines to correct the host information. For more
information about how to use the CSC configuration command-lines, refer to "CSC
configuration command-line tools" on page 18.

MOE
options

Value
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Set Built-in
Admin
Password

Set the password for the built-in Admin account. For more information
about the Admin account, refer to "The built-in Admin user account" on
page 17.

Confirm
Password

Confirm the password for the built-in Admin account.

MOE
Server

The server name or the IP address of the MOE Web server.

IO Web
Service
Port

The I/O connection port used for MOE. By default, this value is 51443.

WinRM
Service
Port
(optional)

Windows Remote Shell port. By default, the value is 5985. CSC uses this
port to run the capprofile command remotely to get consumption data from
the Capacity Advisor. If this option is not set, CSC does not populate
consumption data from Capacity Advisor and no content will be displayed
in the Organization:Services consumption detail list report. In
addition, if this option is not set, an automated task cannot be run and you
must manually generate a users.txt file after you complete the installation.
For more information, refer to "Running Automated Process Manager
tasks for MOE" on page 25.

Chargeback
Web
Service
Port

The port used for the chargeback Web service. By default, the value is
55443.

User Name

The user name of the MOE administrator.

Password

The password of the MOE administrator.

Active
Directory
options
(optional)

Value

Server

The server name or the IP address of the Active Directory server that is
integrated with MOE and manages MOE users.

Port

The port used by the Active Directory server that is integrated with MOE
and manages MOE users.

User Name

The user name of the Active Directory administrator who has the
privileges to get all managed MOE users.

Password

The password of the Active Directory administrator.
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Certificate
File

If the Active Directory uses SSL, specify the certificate file used for SSL
in this field.

CSA
options

Value

Set Built-in
Admin
Password

Set the password for the built-in Admin account. For more information
about the Admin account, refer to "The built-in Admin user account" on
page 17.

Confirm
Password

Confirm the password for the built-in Admin account.

Server

The server name or the IP address of the CSA Web server.

Port

The port used for CSA Cloud Service Management Console. By default,
this value is 8444.

User Name

The user name of the CSA administrator.

Password

The password of the CSA administrator.

Active
Directory
options

Value

Server

The server name or the IP address of the Active Directory server that
manages the CSA users.

Port

The port used by the Active Directory server that manages the CSA
users.

User Name

The user name of the Active Directory server administrator.

Password

The password of the Active Directory server administrator.

Certificate
File

The certificate file used for SSL.

f. After you finish the preparation state, click Install to start the installation.
3. When the configuration command-line window appears, DO NOT close the window. After the
configuration is completed, press any key to continue.
4. On the finish stage, check the I want to install Crystal Report check box, and then click
Finish. The SAP Crystal Report Server will be installed on the server where CSC is installed.
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Note: To utilize the reporting services provided by CSC, you must have SAP Crystal
Report Server installed. If you do not check this check box, you may have to manually use
the Crystal Report command-line tool to install this component later.
For more information about how to install Crystal Report manually, refer to
"InstallCRSAndImportReport.bat" on page 21.

Activating CSC
CSC is released with a 60-day instant-on license. CSC can be automatically activated with this
built-in instant-on license when the first time you open Application Designer.This Instant-on license
expires after 60 days and cannot be reused.
After the instant-on license expires, to use the full functionality of CSC, you must use HP
AutoPass License Management Tool to activate both CSC and the integration connector.
AutoPass is now automatically installed by the CSC installation package.

Obtaining HP AutoPass License Keys
To connect to the CSC database, you will require HP AutoPass License Keys. The License Keys
provided to you by HP contain authorizations to use CSC functions and related services that you
have acquired with your contract. They also determine:
l

The number of authorized users (Named and Floating).

l

The number of guest users.

License keys are obtained and installed during the initial installation and can be updated
periodically.
Every time you obtain new License Keys, they must be added to the existing set recorded in the HP
AutoPass License Management Tool.

Installing HP AutoPass License Keys
HP AutoPass License Management Tool stores a set of installed License Keys in the LicFile.txt
file located in the data folder of the AutoPass installation folder. By default, the folder is C:\Program
Files\HP\Asset Manager 9.40xx\autopass\data.
Caution: You need two License Keys to activate both CSC and the integration connector.
Activating CSC
After you receive the CSC License Key files, follow these steps:
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1. Launch the HP AutoPass License Management Tool from the CSC program group, for
example, Windows Start/ All programs/ HP/Asset Manager 9.40 en menu.
2. Select Install/Restore License Key from file.
3. Click Browse to select the file you have received for activating CSC.
4. Click View file contents. The list of license rights is displayed.
5. Check the license in the Please check the licenses to be installed, and click Install. When
the color of the rights change to green, it indicates that they have been installed.
6. You can check which license keys are recorded in the HP AutoPass License Management
Tool by selecting Report License Key.
7. If you want to backup and/or replicate those rights to another computer, select Backup
License File. This operation creates a .dat file that you can install or restore using the
Install/Restore License Key from file command.
8. Close AutoPass.
To complete the activation, you must carry out two more procedures:
1. Activate the database using CSC Application Designer after installing a new or modified
License Key file. To do this, follow these steps:
a. Launch the Application Designer.
b. On the File menu, click Open.
c. Click Open existing database, and then click OK.
d. Connect to the HPCloudChargebackSystem database.
e. On the Action menu, click Activate database. The Database activation window appears,
click OK.
Activating the integration connector
After you receive the integration connector License Key files, follow these steps:
1. Launch the HP AutoPass License Management Tool that is located in the
<InstallDIR>\cit\AutoPass\ directory. By default, it is C:\Program Files (x86)
\HP\Asset Manager 9.40 en\cit\bin\runAutoPassGui.bat.
2. Select Install/Restore License Key from file.
3. Click Browse to select the file you have received for activating the integration connector.
4. Click View file contents. The list of license rights is displayed.
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5. Check the license in the Please check the licenses to be installed, and click Install. When
the color of the rights change to green, it indicates that they have been installed.
6. You can check which license keys are recorded in the HP AutoPass License Management
Tool by selecting Report License Key.
7. If you want to backup and/or replicate those rights to another computer, select Backup
License File. This operation creates a .dat file that you can install or restore using the
Install/Restore License Key from file command.
8. Close AutoPass.
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Chapter 5
Configuring CSC
After the CSC programs are installed, you can customize some settings to configure the system.
These depend on the components and applications that you want to use or integrate with CSC.
This chapter explains these additional operations.
Note: You must configure the Automated Process Manager after you install CSC. For more
information, refer to "Configuring automated tasks" on page 23.

The built-in Admin user account
Other than the organization user/consumer, organization/department manager, and CSC
administrator user roles, there is a special user (the Admin user account) who has the highest
privilege to perform any operations on the CSC database and can access all the database
information with no restrictions.
Note: Do not confuse the Admin user account with a user with CSC administration rights.
The password associated with the Admin user account is critical, because it gives all rights to the
CSC database.
Caution: Do not forget the password of the Admin user account. Should this happen, you will
have no other means of administering the database if the other administrative-rights records in
the table of departments and employees are damaged. If you forget this password, there is no
way of recovering it using CSC. You must call HP support to recover the password.

Caution: You must not tell this password to any unauthorized employees.

Note: The user name of this account is unique and cannot be changed. Therefore, make sure
there is no user named Admin in MOE. Otherwise, that user cannot be ported from MOE to
CSC.

Modifying the password of the built-in Admin user
account
When you install CSC, the CSC installer prompts to change the password of the Admin user
account. After the installation is completed, you can also modify the password of the Admin user
account by following these steps:

HP Cloud System Chargeback (9.40)

Page 17 of 43

Installation and Configuration
Chapter 5: Configuring CSC

1. Stop CSC services. To do this, run Windows Start/ All programs/ HP/Asset Manager 9.40
en/Stop Service.
2. Locate the Modify_CSCBuiltInAdmin_Password.bat file in the
<CSCInstallFolder>\csctools folder.
3. Right-click Modify_CSCBuiltInAdmin_Password.bat file, click Run as administrator.
4. In the command-line window, follow the instructions:
a. Enter current password for built-in Admin of CloudSystem Chargeback Action:
Enter the password that you specified when you install CSC.
b. Enter new password for built-in Admin of CloudSystem Chargeback Action: Enter
the new password for the Admin user account.
c. Press any key to finish the configuration.

CSC configuration command-line tools
CSC provides a set of command-line tools that you can use to configure fundamental settings such
as the MOE/CSA host information, migration to more advanced database server, and changing the
password of the itam account.
l

MOEConfig.bat/CSAConfig.bat

l

InstallCRSAndImportReport.bat

l

MigrateDB.bat

l

Modify_SQL_itam_Password.bat

MOEConfig.bat
You can run the MOEConfig.bat command-line tool to specify the host information that is used to
connect to MOE. The host information of MOE has been specified when you run the installer. You
need to run this command-line tool only if the host information you specified during the installation is
incorrect and you cannot successfully integrate MOE with CSC.
Note: This tool is only used for CSC for MOE. You must not run this tool if you are running
CSC for CSA.
To use this command-line tool, follow these steps:
1. Stop CSC services. To do this, run Windows Start/ All programs/ HP/Asset Manager 9.40
en/Stop Service
2. Locate the MOEConfig.bat file in the <CSCInstallFolder>\csctools folder.
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3. Right-click MOEConfig.bat file, click Run as administrator.
4. In the command-line window, follow the instructions:
a. Use an Active Directory Server to synchronize user? Action: If MOE runs along with
Active Directory, enter Y. Otherwise, enter N. If you enter Y:
i. Enter Active Directory Server Action: Enter the IP address or the server name of
the Active Directory that is used by MOE to manage MOE users.
ii. Enter Active Directory Server Port Action: Enter the port that is used by the Active
Directory server.
iii. Enter Active Directory Server Admin Action: Enter the administrator name of the
Active Directory server.
iv. Enter Password for <AD Admin>: Action: Enter the password for the Active
Directory administrator.
v. Use a secure connection (SSL) to the Active Directory Server Action: If SSL is
used for the Active Directory server, enter Y. Otherwise, enter N.
i. Enter SSL Certificate File Path Action: Enter the SSL certificate file path.
b. Enter Admin Password of current Cloud Chargeback System Action: Enter the
password of the built-in Admin user account.
c. Enter Crystal Reports Server Name Action: Enter the address of the Crystal Report
server.
d. Enter Crystal Reports Server Port Action:Enter the port that is used by the Crystal
Report server.
e. Enter the host name (or IP address) for MOE web service Action: Enter the address of
the MOE server.
f. Enter the port for MOE chargeback web service Action: Enter the port used by the
MOE chargeback service.
g. Enter the IO Web Service Port Action: Enter the I/O connection port used for MOE.
h. Enter the Chargeback Web Service Port Action: Enter the port used for the chargeback
Web service.
i. Retrieve consumption data from Capacity Advisor Action: Enter Y if you want to
retrieve consumption data. Otherwise, enter N. If you enter Y:
i. Enter the port for WinRM server Action: Enter the port used for the used for
Windows Remote Management server.
j. Enter the user name for MOE web service Action: Enter the user name of the MOE
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administrator.
k. Enter the password for MOE web service Action: Enter the password of the MOE
administrator.
l. Press any key to finish the configuration.

CSAConfig.bat
You can run the CSAConfig.bat command-line tool to specify the host information that is used to
connect to CSA. The host information of CSA has been specified when you run the installer. You
need to run this command-line tool only if the host information you specified during the installation is
incorrect and you cannot successfully integrate CSA with CSC.
Note: This tool is only used for CSC for CSA. You must not run this tool if you are running
CSC for MOE.
To use this command-line tool, follow these steps:
1. Stop CSC services. To do this, run Windows Start/ All programs/ HP/Asset Manager 9.40
en/Stop Service
2. Locate the CSAConfig.bat file in the <CSCInstallFolder>\csctools folder.
3. Right-click CSAConfig.bat file, click Run as administrator.
4. In the command-line window, follow the instructions:
a. Enter Active Directory Server Action: Enter the IP address or the server name of the
Active Directory that is used by CSA to manage CSA users.
b. Enter Active Directory Server Port Action: Enter the port that is used by the Active
Directory server.
c. Enter Active Directory Server Admin Action: Enter the administrator name of the Active
Directory server.
d. Enter Password for "Admin": Action: Enter the password for the Active Directory
administrator.
e. Use a secure connection (SSL) to the Active Directory Server Action: If SSL is used
for the Active Directory server, enter Y. Otherwise, enter N. If you enter Y:
i. Enter SSL Certificate File Path Action: Enter the SSL certificate file path.
f. Enter Admin Password of current Cloud Chargeback System Action: Enter the
password of the built-in Admin user account.
g. Enter Crystal Reports Server Name Action: Enter the address of the Crystal Report
server.
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h. Enter Crystal Reports Server Port Action:Enter the port that is used by the Crystal
Report server.
i. Enter the host name (or IP address) for CSA server Action: Enter the address of the
CSA server.
j. Enter the port for CSA Server Action: Enter the port used by the CSA server.
k. Enter the user name for CSA server Action: Enter the user name of the CSA
administrator.
l. Enter the password for CSA server Action: Enter the password of the CSA
administrator.
m. Press any key to finish the configuration.

InstallCRSAndImportReport.bat
If you want to use the CSC reporting services, and you do not install SAP Crystal Report during the
installation, you must run the InstallCRSAndImportReport.bat command-line tool to manually
install Crystal Report. To do this, follow these steps:
1. Stop CSC services. To do this, run Windows Start/ All programs/ HP/Asset Manager 9.40
en/Stop Service
2. Click Start, type cmd, right-click cmd.exe, and then click Run as administrator.
3. Type cd <CSCInstallFolder>\csctools, and then press Enter.
4. Type InstallCRSAndImportReport.bat "<CrystalReportPath>" <built-in Admin
password>, and then press Enter.
Note: The <CrystalReportPath> placeholder represents the directory that saves the
Crystal Report installation files. By default, the Crystal Report installation files are saved
in the CrystalReport folder of the installation media. The <built-in Admin password>
placeholder represents the password of the built-in Admin account. For more information
about the built-in Admin account, refer to "The built-in Admin user account" on page 17.
5. Press any key to finish the configuration.

MigrateDB.bat
By default, CSC installs SQL Server 2012 Express edition as the database server. However, you
can upgrade the database server to a more advanced edition such as SQL Server 2012 Enterprise
edition. To do this, you must migrate the database using the MigrateDB.bat command-line tool.
To use this command-line tool, follow these steps:
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1. Stop CSC services. To do this, run Windows Start/ All programs/ HP/Asset Manager 9.40
en/Stop Service
2. Locate the MigrateDB.bat file in the <CSCInstallFolder>\csctools folder.
3. Right-click MigrateDB.bat file, click Run as administrator.
4. In the command-line window, follow the instructions:
a. Enter SQL Server Instance Name Action: Enter the target SQL Server instance name.
b. Enter New Database Name Action: Enter the new database name.
c. Use windows authentication to login SQL server? Action: If you want to use Windows
authentication, enter Y. Otherwise, enter N. If you enter N:
i. Enter SQL Server Login: Action: Enter the SQL Server log on account.
ii. Enter SQL Server Login Password Action: Enter the password of the SQL Server
log on account.
5. Enter Admin Password of current Cloud Chargeback System: Enter the password of the
built-in Admin user account.
6. Press any key to finish the configuration.

Modify_SQL_itam_Password.bat
During the installation, the database is declared to Microsoft SQL Server using an instance using a
user account that is called itam. This account is only used during the installation and is no longer
required for any operations in CSC. However, we strongly recommend that you change the
password of this account for security considerations. To do this, follow these steps:
1. Stop the CSC services. To do this, run Windows Start/ All programs/ HP/Asset Manager
9.40 en/Stop Service.
2. If you are running the CSC Windows client, close it.
3. Locate the Modify_SQL_itam_Password.bat file in the <CSCInstallFolder>\csctools
folder.
4. Right-click Modify_SQL_itam_Password.bat file, click Run as administrator.
5. In the command-line window, follow the instructions:
a. Use windows authentication to login SQL server (localdb)\.\v11.0? Action: If you use
Windows authentication to log on to SQL Server (which is recommended), enter Y.
Otherwise, enter N. If you enter N:
i. Enter SQL Server Login Action: Enter the SQL Server log on account.
ii. Enter SQL Server Login Password Action: Enter the password of the SQL Server
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log on account.
b. Enter new Login Password for itam Action: Enter the new itam password.
c. Press any key to finish the configuration.

Configuring automated tasks
CSC includes a system for monitoring schedules and automatically triggering actions. This
program, called Automated Process Manager, functions independently of CSC.
Automated Process Manager automatically runs and monitors all the scheduled tasks in the
chargeback database.
In order for these functions to work properly, you must run Automated Process Manager on at least
one computer permanently and connect it to your production database.

Recommendations
Automated Process Manager needs to frequently access the database, therefore:
l

If there is a workstation with a high-speed connection to the database, run Automated Process
Manager from this workstation. Monitoring will be performed for all users.

l

If you can only access the database over a low-speed link, you can run Automated Process
Manager directly on the server.

If you modify the structure of the database using Application Designer or using the commandline,
you must disconnect Automated Process Manager from the database and then reconnect.

Running Automated Process Manager
To ensure that expense lines are generated with accurate creation date, Automated Process
Manager must run constantly against the CSC database.

Manually run Automated Process Manager
You can launch the Automated Process Manager program from the programs from the CSC
program group of the Start menu.
Note: When you disconnect Automated Process Manager from the database, all monitoring
functions and automatic triggering of action are suspended. When you connect to the database
in CSC, CSC displays a warning message indicating that Automated Process Manager has
not accessed the database in the last hour.

Connecting Automated Process Manager to a database
Only the built-in Admin user can connect to the database with Automated Process Manager.
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For more information about the Admin user, refer to "The built-in Admin user account" on page 17.
You need to enter the relevant user account and password. Select the Use this connection in
service mode check box if you want to use this connection as the default connection if Automated
Process Manager is running in service mode (as in an NT service).
To connect Automated Process Manager to a database, click Connect to database on the File
menu.
Similarly, to disconnect Automated Process Manager from a database, click Disconnect to
database on the File menu.

Automated Process Manager tasks
After you install CSC, you need to activate several Automated Process Manager tasks to start the
data migration from MOE or CSA. To do this, follow these steps:
1. Start Automated Process Manager.
2. On the file menu, click Connect to database.
3. In the Connect to database dialog box, select the HPCloudChargeBackSystem database,
and then log on using the Admin account.
4. On the Action menu, click Activate.
5. Run the tasks by the following the instructions that are described in "Running Automated
Process Manager tasks for MOE" on the facing page or "Running Automated Process Manager
tasks for CSA" on page 27.
Caution: Some tasks may rely on the data processed by other tasks. Therefore, you must
not run the tasks simultaneously. That is, open the Activating window, select a module,
click OK. After a task is run completely, open the Activating window again, select
another task, click OK. Repeat this step until all the tasks are run.

n

Synchronize Department and Employee From AD

n

Import organization info from MOE to AM, and create a default budget center for each
organization

n

Generate users.txt using winrs command

n

Find MOE/CSA local group's member info (when Active Directory is used to manage user
information)

n

Find MOE/CSA AD group's member info (when Active Directory is used to manage user
information)

n

Import service instance from MOE/CSA to AM, meanwhile, create subscription in AM
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n

Import usage detail data from MOE to AM (table amResUsageDetail)

n

Retrieve consumption data from Capacity Advisor.

Running Automated Process Manager tasks for MOE
Caution: Some tasks may rely on the data processed by other tasks. Therefore, you must not
run the tasks simultaneously. That is, open the Activating window, select a module, click OK.
After a task is run completely, open the Activating window again, select another task, click
OK. Repeat this step until all the tasks are run.
After CSC is installed, some business data must be initialized by running Automated Process
Manager tasks. To do this, follow these steps:
1. In Automated Process Manager, run the Import organization info from MOE to AM, and
create a default budget center for each organization task.
2. If MOE is integrated with Active Directory, run the Synchronize Department and Employee
From AD task.
a. If Active Directory has a billing code property, modify the scenario file by following the
instructions in"Importing billing code to CSC by modifying the scenario file" on page 28.
Then, run the following tasks to build relationship between user and organization.
o

Generate users.txt using winrs command

o

Find MOE local group's member info

o

Find MOE AD group's member info

b. If Active Directory does not have a billing code property. Run the following tasks to build
relationship between user and organization.
o

Generate users.txt using winrs command

o

Find MOE local group's member info

o

Find MOE AD group's member info

Then, log on to CSC with a CSC administrator account to manually create billing centers
and assign billing centers to users.
For more information about how to manually create billing centers, refer to User Manual,
chapter CSC functionalities and user interfaces, section Finance
management>Billing centers.
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For more information about how to assign billing centers to users, refer to User Manual,
chapter CSC functionalities and user interfaces, section Organization
management>User and organization unit.
Note: If you do not specify the WinRM Service Port during the installation or using the
configuration command-line, you must not run the Generate users.txt using winrs
command task. Instead of running the Generate users.txt using winrs command task,
follow these steps:
Step 1: Disable the Generate users.txt using winrs command task in Automated
Process Manager. To do this, on the Tools menu, click Configure modules, click the
GET_WINRS_USER module, uncheck the Enabled check box.
Step 2: On the server that hosts MOE (not the CSC server), create a .bat file with the
following commands:
net localgroup > C:\group.txt
for /F "skip=5 delims=*" %%u in (C:\group.txt) do net localgroup "%%u" >>
C:\users.txt
Step 3: Copy the c:\users.txt file on the MOE server to the
INSTDIR%\cit\scenario\moe\scenario\getWinUser folder on the CSC server. If a
users.txt file already exists on the CSC server, replace it with the new users.txt file.
Step 4: Continue to run the Find MOE local group's member info task and the Find
MOE AD group's member info task.
3. If MOE is not integrated with Active Directory, run the following tasks:
n

Generate users.txt using winrs command

n

Find MOE local group's member info

Then, log on to CSC with a CSC administrator account to manually create billing centers and
assign billing centers to users.
For more information about how to manually create billing centers, refer to User Manual,
chapter CSC functionalities and user interfaces, section Finance management>Billing
centers.
For more information about how to assign billing centers to users, refer to User Manual,
chapter CSC functionalities and user interfaces, section Organization
management>User and organization unit.
Note: If you do not specify the WinRM Service Port during the installation or using the
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configuration command-line, you must not run the Generate users.txt using winrs
command task. Instead of running the Generate users.txt using winrs command task,
follow these steps:
Step 1: Disable the Generate users.txt using winrs command task in Automated
Process Manager. To do this, on the Tools menu, click Configure modules, click the
GET_WINRS_USER module, uncheck the Enabled check box.
Step 2: On the server that hosts MOE (not the CSC server), create a .bat file with the
following commands:
net localgroup > C:\group.txt
for /F "skip=5 delims=*" %%u in (C:\group.txt) do net localgroup "%%u" >>
C:\users.txt
Step 3: Copy the c:\users.txt file on the MOE server to the
INSTDIR%\cit\scenario\moe\scenario\getWinUser folder on the CSC server. If a
users.txt file already exists on the CSC server, replace it with the new users.txt file.
Step 4: Continue to run the Find MOE local group's member info task.
4. Configure currency settings. For more information about currency settings, refer to User
Manual, chapter CSC functionalities and user interfaces, section Finance
management>Currencies.
5. If you want to utilize the budget management provided by CSC, log on to CSC with a CSC
administrator account and configure the financial year, budgets centers, budgets, and budget
lines. For more information about budget settings, refer to User Manual, chapter CSC
functionalities and user interfaces, section Finance management.
6. Run the Import service instance from MOE to AM, meanwhile, create subscription in
AM task.
7. Run the Import usage detail data from MOE to AM(table amResUsageDetail) task.
8. Run the Retrieve consumption data from Capacity Advisor task.

Running Automated Process Manager tasks for CSA
Caution: Some tasks may rely on the data processed by other tasks. Therefore, you must not
run the tasks simultaneously. That is, open the Activating window, select a module, click OK.
After a task is run completely, open the Activating window again, select another task, click
OK. Repeat this step until all the tasks are run.

Caution: Before you run any tasks, make sure that e-mail address is assigned for the LDAP
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users on the LDAP server.
After CSC is installed, some business data must be initialized by running Automated Process
Manager tasks. To do this, follow these steps:
1. If the Active Directory associated with CSA has a billing code property, modify the scenario file
by following the instructions in"Importing billing code to CSC by modifying the scenario file"
below. Then, run the Synchronize Department and Employee From AD task.
2. If the Active Directory does not have a billing code property, use the built-in Admin account to
log on to CSC and grant a user the CSC administrator role. Then, use the CSC administrator
account to log on to CSC, create billing centers and assign billing centers to users.
For more information about the Admin account, refer to "The built-in Admin user account" on
page 17.
For more information about how to manually create billing centers, refer to User Manual,
chapter CSC functionalities and user interfaces, section Finance management>Billing
centers.
For more information about how to assign billing centers to users, refer to User Manual,
chapter CSC functionalities and user interfaces, section Depart management>User and
department.
3. Configure currency settings. For more information about currency settings, refer to User
Manual, chapter CSC functionalities and user interfaces, section Finance
management>Currencies.
4. Configure exchange rate settings. For more information about exchange rate settings, refer to
User Manual, chapter CSC functionalities and user interfaces, section Finance
management>Exchange rate.
5. If you want to utilize the budget management provided by CSC, log on to CSC with a CSC
administrator account and configure the financial year, budgets centers, budgets, and budget
lines.
For more information about budget settings, refer to User Manual, chapter CSC
functionalities and user interfaces, section Finance management.
6. Run the Import subscription info from CSA to AM task.
7. Run the Import service instance info from CSA to AM task.

Importing billing code to CSC by modifying the scenario
file
After you install CSC, you can log on to CSC as a CSC administrator to assign billing code for each
user. Alternatively, if your MOE/CSA environment is integrated with Active Directory and there
exists the billing code property in Active Directory, the billing code information can be imported into
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CSC automatically. To do this, modify a scenario file before you run the Automated Process
Manager tasks.
Note: This method can be used only when the billing code property is associated with the
individual users in Active Directory. For example, if the billing code property is associated with
the organization, you cannot use this method to automatically import billing code. If the billing
code property is not associated with the users, you must run the integration connector (HP
Connect-It) to modify the scenario accordingly. To do this, you must have strong knowledge of
Connect-It. For more information about the relevant Connect-It knowledge, refer to the
Connect-It documentation in the CSC installation folder (<CSCInstallFolder>\cit\doc.)
To modify the scenario file, follow these steps:
1. Locate one of the following files:
n For MOE, if Active Directory uses SSL: %CSC_INSTALL_
DIR%\cit\scenario\moe\scenario\ad_usr.scn
n

For MOE, if Active Directory does not use SSL: %CSC_INSTALL_
DIR%\cit\scenario\moe\scenario\ad_usr_nossl.scn

n

For CSA, if Active Directory uses SSL: %CSC_INSTALL_
DIR%\cit\scenario\csa\CSA3.0\scenario\ad_usr.scn

n

For CSA, if Active Directory does not use SSL: %CSC_INSTALL_
DIR%\cit\scenario\csa\CSA3.0\scenario\ad_usr_nossl.scn

2. Open the file with a text editor.
3. Find the following lines:
<PifFormat Version="3.0" FormatId="organizationalPerson">
<STRUCTURE Name="organizationalPerson">
4. Below these two lines, insert the following line:
<ATTRIBUTE Name="billCode" Type="String"/>
Note: You must replace the place holder billCode with the billing code property in your
Active Directory.
5. Find the following line:
;strBillingCode = ""</Property>
Replace this line with:
;strBillingCode = "[billCode]"</Property>
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Note: You must replace the place holder billCode with the billing code property in your
Active Directory.
6. Save the scenario file.

Automated Process Manager verification schedules
To define the verification schedules of a module:
1. Select the Tools/ Configure modules menu.
2. Select the module to configure.
3. Populate fields in the Verification schedules zone.
4. If necessary, create and populate additional sub-tabs by right-clicking the labels of the subtabs and selecting the Add a rule menu.
The sub-tabs are used to enable you to define the days and times of monitoring.

Value of the
Days field

Monitoring is performed

"Daily"

Every day of the year, without exception.

"Day of the
week:"

The weekday selected from an itemized list in the field to the right of the Days
field.
Example
Every Monday

"Day of the
year:"

A day or selection of days. These are defined via the Day, Month and Year
check boxes.
Example
July 20

"The first"
"The second"
"The third"
"The fourth"
"The next to
last"
"The last"
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The days of the week defined using the Day check box, and for the month(s)
and year(s) defined using the Month and Year check boxes.
Examples
"The first" Friday of each month.
"The second" Monday of the month of September.
"The next to last" Wednesday of the month of November.
"The last" Tuesday of every month throughout 2000.
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Monitoring times
Periodical
You can define two frequencies for the verification of a module that depend on the time of day.
The first During period frequency applies to scheduled periods that you can create in two ways:
l

Graphically, using the schedule bar. Click and drag on this bar to create a schedule period.

l

Directly, by entering an itemized list of values in the field to right of the schedule bar. The
following syntax is used:
<Start time of period> - <End time of period>

The time format defined in Asset Manager must be respected.
To indicate several periods of time, you just need to separate them with semi-colons ";".
The second Outside of period frequency is applied outside of those scheduled periods you have
defined.
Example:

Itemized list
You can enter those times you want the verification to be carried out on in the field to the right.
l

The time format defined in Asset Manager must be respected.

l

The semi-colon ";" is used to separate them.
Example:

Preview
You can have a preview of:
l

A rule defining the monitoring schedules of a module in the Preview field of a rule description
sub-tab.

l

All the rules concerning a module in the Preview sub-tab of the Modules tab, once the module is
selected.
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Starting and stopping the CSC services
After you complete installing and configuring CSC, you must start the CSC services to make it
function. To do this, run Windows Start/ All programs/ HP/Asset Manager 9.40 en/Start
Service.
When you try to uninstall or perform system maintenance, you must stop the CSC services. To do
this, run Windows Start/ All programs/ HP/Asset Manager 9.40 en/Stop Service.
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After CSC is installed, you can added or removed CSC components through the Add or Remove
Programs utility in the Control Panel.

Before you uninstall CSC
Before you uninstall CSC, pay attention to the following factors.
l

The demonstration database: The demonstration database is deleted during the
uninstallation.You need to make a copy of the demonstration database if you want to keep it.
The demonstration database is saved in the <drive>:\Users\<user
name>\AppData\Roaming\HP\CSC\database folder.
Note: You may need to temporarily stop any services such as SQL Server which access
the database and thus might lock the file and prevent it being deleted.

l

The Web server: Before you uninstall CSC, you must stop the application servers being used
by CSC Web Tier and CSC Web Service in order to unlock the files that will be uninstalled.

Uninstalling CSC
To completely remove CSC from a computer, run the Programs and Features utility in the
Windows Control Panel. Then, remove both HP Asset Manager 9.40 (en) and HP Asset Manager
CloudSystem Chargeback 9.40 (en).
Note: After you uninstall CSC, some data still remains in the install folder of CSC. You need to
manually delete the CSC install folder to completely remove CSC from a computer.
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Installing and configuring CSC for CSA with
LDAP services other than Active Directory
By default, CSC provides out-of-the-box (OOB) installer and configuration tools when Active
Directory is leveraged to manage user and department information for CSA. In addition, CSC also
supports the use of LDAP services other than Active Directory. If you use LDAP services other
than Active Directory, you must read the instructions described in this chapter.

Installing and configuring CSC for CSA with LDAP
services other than Active Directory
Note: When you use LDAP service other than Active Directory, in the automated task names,
the term "Active Directory" or "AD" represents the LDAP service that you use.
Installing CSC for CSA with LDAP services other than Active Directory
When you run the CSC installer by following the instructions that are described in the "Installation
procedure" on page 11 section, you must replace the Active Directory properties with your LDAP
service properties:

LDAP
options

Value

Server

The server name or the IP address of the LDAP server that manages the CSA
users.

Port

The port used by the LDAP server that manages the CSA users.

User Name

The user name of the LDAP server administrator.

Password

The password of the LDAP server administrator.

Certificate File

The certificate file used for SSL.

Configuring CSC for CSA with LDAP services other than Active Directory
When you run the CSAConfig.bat command-line tool to modify the connection settings by following
the instructions that are described in the "CSAConfig.bat" on page 20 section, you must replace the
Active Directory properties with your LDAP service properties:
1. Enter Active Directory Server Action: Enter the IP address or the server name of the LDAP
server that is used by CSA to manage CSA users.
2. Enter Active Directory Server Port Action: Enter the port that is used by the LDAP server.
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3. Enter Active Directory Server Admin Action: Enter the administrator name of the LDAP
server.
4. Enter Password for "Admin": Action: Enter the password for the LDAP administrator.
5. Use a secure connection (SSL) to the Active Directory Server Action: If SSL is used for
the LDAP server, enter Y. Otherwise, enter N. If you enter Y:
a. Enter SSL Certificate File Path Action: Enter the SSL certificate file path.

Modifying the user and department
synchronization task
Note: When you use LDAP service other than Active Directory, in the automated task names
and scenario files, the term "Active Directory" or "AD" represents the LDAP service that you
use. Do not rename the terms.

Note: To modify the user and department synchronization task, you must have the related HP
Connect-It knowledge. For more information about how to use Connect-It, refer to the ConnectIt documentation that is included in the CSC installation folder (<CSCInstallFolder>\cit\doc.)
After CSC for CSA is installed. You must modify the Synchronize Department and Employee
from AD task corresponding to the LDAP service that CSA uses to manage the user and
department information.
1. Locate one of the following files:
n When the LDAP service uses SSL, locate %CSC_INSTALL_
DIR%\cit\scenario\csa\CSA3.0\scenario\ad_usr.scn
n

When the LDAP service does not use SSL, locate %CSC_INSTALL_
DIR%\cit\scenario\csa\CSA3.0\scenario\ad_usr_nossl.scn

2. Double-click the ad_usr.scn file or the ad_usr_nossl.scn file. By default, the integration
connector (HP Connect-It) is opened to edit the .scn (scenario) file.
3. In the Scenario diagram pane, delete all the mappings on the User mapping mapping box.
4. Right-click the Active Directory connector, click Configure connector.
5. In the Configure the connector wizard, populate the information for the LDAP service.
6. Right-click the Active Directory connector, click Open connector. In the Produced
document types pane, create the produced document types for the users, departments, and
department managers.
7. Click the User mapping mapping box, on the Mappings tab, create mappings to import users,
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departments, and department managers to CSC. To do this, populate the following fields of the
amEmplDept table.

Field

bDepartment
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Type

System
item list
n

0- No

n

1- Yes

Description

Be assigned as 1 when the
processing document
represents organization
unit.

Mandat
ory

Could be
reconcilia
tion key

No

No
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Email

String, up to E-mail address of the
40
employee or department.
characters
Use the following formats:
n

MAPI standard (Internet
Mail, Microsoft Outlook,
etc.):

Yes
No
(optional
for
departme
nt)

MAPI:<Name of the
mailbox>
Example:
MAPI:CathyBernard@t
altek.com
n

VIM standard (Lotus
Notes, etc.):
VIM:<[name/domain,
without accented or
special characters]>
Example:
VIM:Colombo/TALTEK

n

SMTP standard (Internet
standard):
SMTP:name@address.
domain
Example:
SMTP:Colombo@taltek
.com

LdapDN

String, up to Distinguished name in
255
LDAP.
characters

Yes

Yes

Name

String, up to Name of employee or
50
department.
characters

No

No
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seLoginClass

System
item list
n

0Named

n

1Floating

n

2- Guest

Employee's database
access type.
n

For the user who will be
assigned role as CSC
administrator, the
value should be 0.

n

For the user who will be
assigned role as
Department manager,
the value should be 0 or
1.

n

For the user who will be
assigned role as
Consumer, the value
should be 2.

Yes
No
(optional
for
departme
nt)

UserLogin

String, up to User name that allows the
36
employee to connect to
characters
CSC. It should be the
same as the user name
which is used to log on to
domain.

Yes
No
(optional
for
departme
nt)

Parent.LdapDN

String, up to Distinguished name of the
255
department to which the
characters
employee or department is
attached.

Yes
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MasterProfiles.SQL
Name

String, up to SQL name of the user roles
32
authorized for the
characters
connection.
The acceptable value lists
are:
n

CSA_Consumer
represents the role
Consumer

n

CSA_DeptMgr
represents the role
Department manager

n

CSA_CSCAdmin
represents the role CSC
administrator

Yes
No
(optional
for
departme
nt)

DefMasterProfile.SQ
LName

String, up to SQL name of the user role
32
assigned to the user for
characters
initial connection.

Yes
No
(optional
for
departme
nt)

CostCenter.Code

String, up to Code of the billing center.
20
characters

No

CostCenter.Title

String, up to Name of the billing center.
30
characters

Yes
No
(optional
for
departme
nt)

Yes

8. Save the scenario file.
9. Start Automated Process Manager. On the Tools menu, click Configure modules.
10. Click the Synchronize Department and Employee from AD task, in the User data item
box:
a. Locate -dc:'Active Directory.DbDescFile'=ldapdbad.cfg, replace the
ldapdbad.cfg string.
o If you use Microsoft Exchange, change to ldapdbex.cfg.
o

If you use IBM z/OS Security Server, change to ldapdbibmzos.cfg.

o

If you use OpenLdap, change to ldapdbol.cfg.
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o

If you use Novell Directory, Netscape Directory Server or others, change to
ldapdball.cfg.

b. Locate -dc:'Active Directory.DateFormat'='%4Y%2M%2D%2H%2N%2.1SZ', replace
%4Y%2M%2D%2H%2N%2.1SZ with %4Y%2M%2D%2H%2N%2SZ.
11. Click Modify to save the changes.
12. Click Close.
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Troubleshooting
This chapter describes some issues that are frequently met and introduces the methods to
diagnose.

Missing of consumption data
If the Organization: Services consumption detail list report does not contain any data, examine
the following settings:
l

Make sure MOE sever has started the Windows Remote Shell service.

l

Make sure that the Windows Remote Shell port specified in CSC is identical to the Windows
Remote Shell port used by MOE. If the port specified in CSC is incorrect, run the
MOEConfig.bat command-line tool to reset it. For more information, refer to "MOEConfig.bat" on
page 18

l

Check the Windows Remote Shell MaxMemoryPerShellMB property on the MOE server. We
recommend that you set the size of this property to 1024 MB or larger. To do this, open a
command-line window, run winrm set winrm/config/winrs @
{MaxMemoryPerShellMB="1024"}.

Missing of Active Directory users and organization
units
If the users and organization units are not imported from Active Directory to CSC after you run the
Automated Process Manager tasks, make sure that the date format in the following Automated
Process Manager tasks is identical to the date format in the Active Directory that manages the
MOE/CSA users.
To do this, follow these steps:
1. Open Automated Process Manager.
2. Use the Admin user account to connect to the HPCloudChargeBackSystem database.
3. On the Tools menu, click Configure modules.
4. Select the Synchronize Department and Employee From AD task, in the User data item
box, locate the -dc:'Active Directory.DateFormat' parameter.
5. By default, the value of the -dc:'Active Directory.DateFormat' parameter is
'%4Y%2M%2D%2H%2N%2.1SZ'. However, if the date format in Active Directory is different from
this format, change this value accordingly.
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Missing of subscription for CSA
If there is no data under My department's service or My service, and you are sure that there are
subscriptions in CSA for the current user, check the user’s email address on the LDAP server.
To do this, follow these steps:
1. Use a LDAP browser tool to connect to the LDAP service that CSA uses.
2. Find the user on LDAP.
3. Check the email address of the user, make sure it is specified.

Synchronization failure
In CSC for MOE, if the user synchronization fails with the following error message in the
cit\scenario\moe\scenario\getWinUser winrs_users.log file:
“(-53) Winrs error:WinRM cannot process the request”,
Modify the Automated Process Manager service by following these steps:
1. Right-click the Automated Process Manager service, click Properties.
2. On the Log On tab, click the This account box, enter a user name who has administrative
right (such as .\admin) and the corresponding password.
3. Click OK.
4. Restart the service.
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We appreciate your feedback!
If you have comments about this document, you can contact the documentation team by email. If
an email client is configured on this system, click the link above and an email window opens with
the following information in the subject line:
Feedback on Cloud System Chargeback, 9.40 Installation and Configuration
Just add your feedback to the email and click send.
If no email client is available, copy the information above to a new message in a web mail client,
and send your feedback to ovdoc-itsm@hp.com.
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